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Some of the content in this topic may not be applicable to some languages.

To print this topic, press TAB to select Show All at the top of the topic, press ENTER, and then press CTRL+P.

Work with the Microsoft Office Assistant, the Help window, and the Ask a Question box


Keyboard shortcuts for using the Help Pane and Help window

The Help Pane is a task pane that provides access to all Office Help content. As a task pane, the Help Pane appears as part of the acvtive application. The Help window displays topics and other Help content and appears as a window next to, but separate from, the active application.

In the Help Pane

To do this

Press

Display the Help Pane.

F1

Switch between the Help Pane and the active application.

F6

Select the next item in the Help Pane.

TAB

Select the previous item in the Help Pane.

SHIFT+TAB

Perform the action for the selected item.

ENTER

In a Table of Contents, select the next and previous item, respectively.

UP ARROW and DOWN ARROW

In a Table of Contents, expand and collapse the selected item, respectively.

LEFT ARROW and RIGHT ARROW

Move back to the previous Task Pane.

ALT+LEFT ARROW

Move forward to the next Task Pane.

ALT+RIGHT ARROW

Open the menu of Pane options.

CONTROL+SPACE

Close and reopen the current Task Pane.

CONTROL+F1

Expand a +/- list.

RIGHT ARROW

Collapse a +/- list.

LEFT ARROW

In the Help window

To do this

Press

Select the next hidden text or hyperlink, or Show All or Hide All at the top of a topic

TAB

Select the previous hidden text or hyperlink, or the Browser View button at the top of a Microsoft Office Web site article 

SHIFT+TAB

Perform the action for the selected Show All, Hide All, hidden text, or hyperlink

ENTER

Move back to the previous Help topic.

ALT+LEFT ARROW

Move forward to the next Help topic.

ALT+RIGHT ARROW

Print the current Help topic.

CONTROL+P

Change whether the Help window appears connected to (tiled) or separate from (untiled) the active application.

ALT+U


Display and use the Office Assistant

To perform the following actions, the Microsoft Office Assistant must be turned on and visible. To turn on or show the Office Assistant, press ALT+H to open the Help menu, and then press O.

In the Assistant balloon

To do this

Press

Close an Assistant message or a tip

ESC


Display and use the Help window

To do this

Press

Display the Help window.

F1

In the Help window

To do this

Press

Select Show All or Hide All at the top of a topic; the next hidden text or hyperlink; or the Browser View button at the top of a Microsoft Office Web site article.

TAB

Select the previous hidden text, hyperlink, Show All, or Hide All

SHIFT+TAB

Perform the action for the selected Show All, Hide All, hidden text, or hyperlink

ENTER

Close the Help window

ALT+F4


Use the Help topic pane

To do this

Press

Go to the next Help topic

ALT+RIGHT ARROW

Go to the previous Help topic

ALT+LEFT ARROW

Select the next hidden text or hyperlink, or Show All or Hide All at the top of a topic

TAB

Select the previous hidden text or hyperlink, or the Browser View button at the top of a Microsoft Office Web site article.

SHIFT+TAB

Perform the action for the selected Show All, Hide All, hidden text, or hyperlink

ENTER

Scroll toward the beginning or end of a Help topic

UP ARROW or DOWN ARROW

Scroll toward the beginning or end of a Help topic in large increments

PAGE UP or PAGE DOWN

Go to the beginning or end of a Help topic

HOME or END

Print the current Help topic

CTRL+P

Select the entire Help topic

CTRL+A

Copy the selected items to the Clipboard

CTRL+C

Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut menu, right-click an item or press SHIFT+F10.)
SHIFT+F10


Use the Ask a Question box

Press F10 or ALT to select the menu bar, and then press TAB until the insertion point appears in the Ask a Question box. Type your question, and then press ENTER.

To select a topic, use the UP or DOWN arrow keys, and then press ENTER to open the topic in the Help window. To select the next or previous set of topics in the Microsoft Office Assistant balloon, select See more or See previous, and then press ENTER.

Use the Microsoft Office interface


Use menus and toolbars

To do this

Press

Select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can be the built-in menu bar or a custom menu bar.), or close an open menu and submenu at the same time

F10 or ALT

When a toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To display a toolbar, press ALT and then SHIFT+F10.) is selected, select the next or previous button or menu on the toolbar

TAB or SHIFT+TAB

When a toolbar is selected, select the next or previous toolbar

CTRL+TAB or CTRL+SHIFT+TAB

Open the selected menu, or perform the action for the selected button or command

ENTER

Display the shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut menu, right-click an item or press SHIFT+F10.) for the selected item

SHIFT+F10

Display the window shortcut menu (Control menu)

ALT+SPACEBAR

When a menu or submenu is open, select the next or previous command

DOWN ARROW or UP ARROW

Select the menu to the left or right. When a submenu is open, switch between the main menu and the submenu.

LEFT ARROW or RIGHT ARROW

Select the first or last command on the menu or submenu

HOME or END

Close an open menu. When a submenu is open, close only the submenu.

ESC

When a menu is selected, display the list of commands

SHIFT+DOWN ARROW

When a personalized menu is open, display the full set of commands

CTRL+DOWN ARROW

Display the Start menu

CTRL+ESC

Enter a name in the Find a Contact box

F11

Note  You can use the keyboard to select any menu command on the menu bar. Press ALT to select the menu bar. Press the letter that is underlined in the menu name that contains the command you want. In the menu that appears, press the letter underlined in the command name that you want.


Move and resize toolbars

Press ALT to select the menu bar (menu bar: The horizontal bar below the title bar that contains the names of menus. A menu bar can be the built-in menu bar or a custom menu bar.). 

Press CTRL+TAB repeatedly to select the toolbar (toolbar: A bar with buttons and options that you use to carry out commands. To display a toolbar, press ALT and then SHIFT+F10.) you want. 

In the toolbar, press CTRL+SPACE to display the Toolbar Options menu. 

Do one of the following: 


Resize a toolbar

Select the Size command, and then press ENTER. 

Use the arrow keys to resize the toolbar. Press CTRL+ the arrow keys to resize one pixel at a time. 


Move a toolbar

Select the Move command, and then press ENTER. 

Use the arrow keys to position the toolbar. Press CTRL+ the arrow keys to move one pixel at a time. To undock the toolbar, press DOWN ARROW repeatedly. To dock the toolbar vertically on the left or right side, press LEFT ARROW or RIGHT ARROW respectively when the toolbar is all the way to the left or right side. 


Use dialog boxes

To do this

Press

Move to the next option or option group

TAB

Move to the previous option or option group

SHIFT+TAB

Switch to the next tab in a dialog box

CTRL+TAB

Switch to the previous tab in a dialog box

CTRL+SHIFT+TAB

Move between options in an open drop-down list, or between options in a group of options

Arrow keys

Perform the action assigned to the selected button; check or clear the selected check box

SPACEBAR

Open the list if it is closed and move to that option in the list

First letter of an option in a drop-down list

Select an option; select or clear a check box

ALT+ the letter underlined in an option

Open a selected drop-down list

ALT+DOWN ARROW

Close a selected drop-down list; cancel a command and close a dialog box

ESC

Perform the action assigned to a default button in a dialog box

ENTER


Use edit boxes within dialog boxes

An edit box is a blank in which you type or paste an entry, such as your user name or the path (path: The route that the operating system uses to locate a folder or file; for example, C:\House finances\March.doc.) to a folder.

To do this

Press

Move to the beginning of the entry

HOME

Move to the end of the entry

END

Move one character to the left or right

LEFT ARROW or RIGHT ARROW

Move one word to the left

CTRL+LEFT ARROW

Move one word to the right

CTRL+RIGHT ARROW

Select or unselect one character to the left

SHIFT+LEFT ARROW

Select or unselect one character to the right

SHIFT+RIGHT ARROW

Select or unselect one word to the left

CTRL+SHIFT+LEFT ARROW

Select or unselect one word to the right

CTRL+SHIFT+RIGHT ARROW

Select from the insertion point to the beginning of the entry

SHIFT+HOME

Select from the insertion point to the end of the entry

SHIFT+END


Use the Open, Save As, and Insert File dialog boxes

The Open, Save As, and Insert File dialog boxes support standard dialog box keyboard shortcuts. (To view standard shortcuts for dialog boxes, refer to the Use dialog boxes and Use edit boxes within dialog boxes sections in this topic.) These dialog boxes also support the shortcuts below.

To do this

Press

Go to the previous folder [image: image15.png]



ALT+1

Up One Level[image: image16.png]


 button: open the folder up one level above the open folder

ALT+2

Search the Web[image: image17.png]


 button: close the dialog box and open your Web search page (search page: A page from which you can find and go to other Internet sites or to documents on an intranet. Many search pages provide various ways to search, such as by topic, by keyword, or by matches to user queries.)
ALT+3

Delete[image: image18.png]


 button: delete the selected folder or file

ALT+4

Create New Folder[image: image19.png]


 button: create a new folder

ALT+5

Views[image: image20.png]


 button: switch among available folder views

ALT+6

Tools button: show the Tools menu

ALT+7 or ALT+L

Display a shortcut menu (shortcut menu: A menu that shows a list of commands relevant to a particular item. To display a shortcut menu, right-click an item or press SHIFT+F10.) for a selected item such as a folder or file

SHIFT+F10

Move between options or areas in the dialog box

TAB

Open the Look in list

F4 or ALT+I

Refresh the file list

F5


Use program windows

To do this

Press

Switch to the next window

ALT+TAB

Switch to the previous window

ALT+SHIFT+TAB

Close the selected program window; if this is the only open window, closes the program

ALT+F4

Move to a pane from another pane in the program window (counterclockwise direction)

SHIFT+F6

When more than one window is open, switch to the next window

CTRL+F6

Switch to the previous window

CTRL+SHIFT+F6

When a document window is not maximized, performs the Move command (on the Control menu for the window). Use the arrow keys to move the window, and, when finished, press ESC.

CTRL+F7

When a document window is not maximized, performs the Size command (on the Control menu for the window). Use the arrow keys to resize the window, and, when finished, press ESC.

CTRL+F8

Minimize a window to an icon (works only for some Microsoft Office programs)

CTRL+F9

Copy a picture of the screen to the Clipboard

PRINT SCREEN

Copy a picture of the selected window to the Clipboard

ALT+PRINT SCREEN

Outlook shortcuts


For basic navigation

To do this

Press

Switch to Mail

CTRL+1

Switch to Calendar

CTRL+2

Switch to Contacts

CTRL+3

Switch to Tasks

CTRL+4

Switch to Notes

CTRL+5

Switch to Folder List in Navigation Pane (Navigation Pane: The column on the left side of the Outlook window that includes panes such as Shortcuts or Mail and the shortcuts or folders within each pane. Click a folder to show the items in the folder.)
CTRL+6

Switch to Shortcuts

CTRL+7

Next item (with item open)

CTRL+COMMA

Previous item (with item open)

CTRL+PERIOD

Switch between the Folder List and the main Outlook window

F6 or CTRL+SHIFT+TAB

Move among the Outlook window, the Navigation Pane, and the Reading Pane

TAB

Move around within the Navigation Pane

Arrow keys

Go to a different folder

CTRL+Y

Expand/collapse a group (with a group selected) in the Navigation Pane

PLUS or MINUS SIGN on the numeric keypad

Collapse/expand a group in the e-mail message list

Left and right arrow keys


To create an item or file

To do this

Press

Appointment

CTRL+SHIFT+A

Contact

CTRL+SHIFT+C

Distribution list

CTRL+SHIFT+L

Fax

CTRL+SHIFT+X

Folder

CTRL+SHIFT+E

Journal entry

CTRL+SHIFT+J

Meeting request

CTRL+SHIFT+Q

Message

CTRL+SHIFT+M

Note

CTRL+SHIFT+N

new Office document.

CTRL+SHIFT+H

Post in this folder

CTRL+SHIFT+S

Search Folder

CTRL+SHIFT+P

Task

CTRL+SHIFT+K

Task request

CTRL+SHIFT+U


For all items

To do this

Press

Display ScreenTip for the active element

SHIFT+F1

Save

CTRL+S or SHIFT+F12

Save and Close, Send

ALT+S

Save As

F12

Undo

CTRL+Z or ALT+BACKSPACE

Delete

CTRL+D

Print

CTRL+P

Copy item

CTRL+SHIFT+Y

Move item

CTRL+SHIFT+V

Check names

CTRL+K (using the Outlook e-mail editor)

Check spelling

F7

Flag for follow-up

CTRL+SHIFT+G

Forward

CTRL+F

Send/post/invite all

ALT+S

Find items

F3 or CTRL+E

Search for text in items

F4

Find next during text search

SHIFT+F4

Use Advanced Find

CTRL+SHIFT+F

Create a new Search Folder

CTRL+SHIFT+P

Turn on editing in a field (except icon view)

F2


For e-mail

To do this

Press

Switch to Inbox

CTRL+SHIFT+I

Switch to Outbox

CTRL+SHIFT+O

Choose the account from which to send a message

CTRL+TAB (with focus on the To line) and then TAB to the Accounts button

Send

ALT+S

Reply to a message

CTRL+R

Reply all to a message

CTRL+SHIFT+R

Mark a message as not junk

CTRL+ ALT+J

Display blocked external content (in a message)

CTRL+SHIFT+I

Post to a folder

CTRL+ SHIFT+S

Check for new mail

CTRL+M or F9

Go to the next message

UP ARROW

Go to the previous message

DOWN ARROW

Go to the row above (message or group heading)

ALT+ UP ARROW

Go to the row below (message or group heading)

ALT+ DOWN ARROW

Compose a new message

CTRL+N

Open a received message

CTRL+O

Display the Address Book

CTRL+SHIFT+B

Convert an HTML or RTF message to plain text

CTRL+SHIFT+O

Add a Quick Flag to a message

INSERT

Display the Flag for Follow Up dialog box

CTRL+SHIFT+G

Mark as read

CTRL+Q

Show the menu to download pictures, change automatic download settings, or add a sender to the Safe Senders List.

CTRL+SHIFT+W


For Calendar

To do this

Press

Accept

ALT+C

Decline

ALT+D

See also under Views, Day/Week/Month view and For Date Navigator.


For Contacts

To do this

Press

Dial

CTRL+SHIFT+D

Enter a name in the Find a Contact box

F11


For Tasks

To do this

Press

Accept

ALT+C

Decline

ALT+D


To format text

To do this

Press

Display the Format menu

ALT+O

Switch case (with text selected)

SHIFT+F3

Add bold

CTRL+B

Add bullets

CTRL+SHIFT+L

Add italics

CTRL+I

Increase indent

CTRL+T

Decrease indent

CTRL+SHIFT+T

Left align

CTRL+L

Center

CTRL+E

Underline

CRTL+U

Increase font size

CTRL+]

Decrease font size

CTRL+[

Cut

CTRL+X or SHIFT+DELETE

Copy

CTRL+C or CTRL+INSERT

Paste

CTRL+V or SHIFT+INSERT

Clear formatting

CTRL+SHIFT+Z or CTRL+SPACEBAR


To add Web information to items

To do this

Press

Edit a URL in the body of an item

CTRL+left mouse button

Specify a Web browser

SHIFT+left mouse button

Insert a hyperlink

CTRL+K (When using Word as e-mail editor only)


For print preview

To do this

Press

Open print preview

CTRL+F2

Print a print preview

ALT+P

Print preview page setup

ALT+S or ALT+U

Zoom

ALT+Z

Close print preview

ALT+C


For send/receive

To do this

Press

Starts send/receive for all defined Send/Receive groups with Include this group in Send/Receive (F9) selected. This can include headers, full items, specified folders, items less than a specific size, or any combination that you have defined.

F9

Starts a send/receive for current folder retrieving full items (header, item, and any attachments)

SHIFT+F9

Views


Table view


For general use

To do this

Press

Open an item

ENTER

Select all items

CTRL+A

Go to the item at the bottom of the screen

PAGE DOWN

Go to the item at the top of the screen

PAGE UP

Extend or reduce the selected items by one item

SHIFT+UP ARROW or SHIFT+DOWN ARROW

Go to the next or previous item without extending the selection

CTRL+UP ARROW or CTRL+DOWN ARROW

Select or unselect the active item

CTRL+SPACEBAR

Move every item in the selection to the top or bottom in the list order

CTRL+HOME or CTRL+END (with in-cell editing disabled)


With a group selected

To do this

Press

Expand the group

ENTER or RIGHT ARROW

Collapse the group

ENTER or LEFT ARROW

Select the previous group

UP ARROW

Select the next group

DOWN ARROW

Select the first group

HOME

Select the last group

END

Collapses the group

NUM -

Expands the group

NUM+

Select the first item on screen in an expanded group or the first item off screen to the right

RIGHT ARROW


For all groups

To do this

Press

Collapses all groups

CONTROL+NUM -

Expands all groups

CONTROL+NUM+


Day/Week/Month view


For all three

To do this

Press

View from 1 through 9 days

ALT+key for number of days

View 10 days

ALT+0 (ZERO)

Switch to weeks

ALT+HYPHEN SIGN

Switch to months

ALT+EQUAL SIGN

Move between Calendar, TaskPad, and the Folder List

CTRL+TAB or F6

Select the previous appointment

SHIFT+TAB

Go to the previous day

LEFT ARROW

Go to the next day

RIGHT ARROW

Move selected item to the previous day when multiple days appear

ALT+LEFT ARROW

Move selected item to the next day when multiple days appear

ALT+RIGHT ARROW

Go to the same day in the next week

ALT+DOWN ARROW

Go to the same day in the previous week

ALT+UP ARROW


For Day view

To do this

Press

Select the time that begins your work day

HOME

Select the time that ends your work day

END

Select the previous block of time

UP ARROW

Select the next block of time

DOWN ARROW

Select the block of time at the top of the screen

PAGE UP

Select the block of time at the bottom of the screen

PAGE DOWN

Extend or reduce the selected time

SHIFT+UP ARROW or DOWN ARROW

Move an appointment

With the cursor in the appointment, ALT+UP ARROW or DOWN ARROW

Change an appointment start or end time

With the cursor in the appointment, ALT+SHIFT+UP ARROW or DOWN ARROW

Move selected item to the same day in the next week

ALT+DOWN ARROW

Move selected item to the same day in the previous week

ALT+UP ARROW


For Week or Month views

To do this

Press

Go to the first day of the week

HOME

Go to the last day of the week

END

Go to the same day of the week in the previous week (or 5 weeks previous if viewing by month)

PAGE UP

Go to the same day of the week in the next week (or 5 weeks ahead if viewing by month)

PAGE DOWN

Move the appointment up, down, left, or right

ALT+UP, DOWN, LEFT, or RIGHT ARROW

Change the duration of the selected block of time

SHIFT+LEFT, RIGHT, UP, or DOWN ARROW; or SHIFT+HOME or END


For Date Navigator

To do this

Press

Go to the first day of the current week

ALT+HOME

Go to the last day of the current week

ALT+END

Go to the same day in the previous week

ALT+UP ARROW

Go to the same day in the next week

ALT+DOWN ARROW

Go to the first day of the month

ALT+PAGE UP

Go to the last day of the month

ALT+PAGE DOWN


For address card views


For general use

To do this

Press

Select a specific card in the list

Type one or more letters of the name the card is filed under or of the field you are sorting by

Select the previous card

UP ARROW

Select the next card

DOWN ARROW

Select the first card in the list

HOME

Select the last card in the list

END

Select the first card on the current page

PAGE UP

Select the first card on the next page

PAGE DOWN

Select the closest card in the next column

RIGHT ARROW

Select the closest card in the previous column

LEFT ARROW

Select or unselect the active card

CTRL+SPACEBAR

Extend the selection to the previous card and unselect cards after the starting point

SHIFT+UP ARROW

Extend the selection to the next card and unselect cards before the starting point

SHIFT+DOWN ARROW

Extend the selection to the previous card, regardless of the starting point

CTRL+SHIFT+UP ARROW

Extend the selection to the next card, regardless of the starting point

CTRL+SHIFT+DOWN ARROW

Extend the selection to the first card in the list

SHIFT+HOME

Extend the selection to the last card in the list

SHIFT+END

Extend the selection to the first card on the previous page

SHIFT+PAGE UP

Extend the selection to the last card on the last page

SHIFT+PAGE DOWN


To move between cards without changing the selection

To use the following keys, make sure a card is selected. To select a card, click the card heading.

To do this

Press

To the next card

CTRL+DOWN ARROW

To the previous card

CTRL+UP ARROW

To the first card in the list

CTRL+HOME

To the last card in the list

CTRL+END

To the first card on the previous page

CTRL+PAGE UP

To the first card on the next page

CTRL+PAGE DOWN

To the closest card in the previous column

CTRL+LEFT ARROW

To the closest card in the next column

CTRL+RIGHT ARROW

To a field in the active card

F2


To move between fields in a card

To use the following keys, make sure a field in a card is selected. To select a field when a card is selected, click the field or press F2.

To do this

Press

Move to the next field and, from the last field of a card, move to the first field in the next card

TAB

Move to the previous field and, from the first field of a card, move to the last field in the previous card

SHIFT+TAB

Move to the next field, or add a line to a multi-line field

ENTER

Move to the previous field without leaving the active card

SHIFT+ENTER

Display the insertion point in the active field to edit text

F2


To move between characters in a field

To use the following keys, make sure a field in a card is selected. To select a field when a card is selected, click the field or press F2.

To do this

Press

Add a line in a multi-line field

ENTER

Move to the beginning of a line

HOME

Move to the end of a line

END

Move to the beginning of a multi-line field

PAGE UP

Move to the end of a multi-line field

PAGE DOWN

Move to the previous line in a multi-line field

UP ARROW

Move to the next line in a multi-line field

DOWN ARROW

Move to the previous character in a field

LEFT ARROW

Move to the next character in a field

RIGHT ARROW


For Timeline view (Tasks or Journal)


When an item is selected

To do this

Press

Select the previous item

LEFT ARROW

Select the next item

RIGHT ARROW

Select several adjacent items

SHIFT+LEFT ARROW or SHIFT+RIGHT ARROW

Select several nonadjacent items

CTRL+LEFT ARROW+SPACEBAR or CTRL+RIGHT ARROW+SPACEBAR

Open the selected items

ENTER

Display the items one screen above the items on screen

PAGE UP

Display the items one screen below the items on screen

PAGE DOWN

Select the first item on the timeline (if items are not grouped) or the first item in the group

HOME

Select the last item on the timeline (if items are not grouped) or the last item in the group

END

Display (without selecting) the first item on the timeline (if items are not grouped) or the first item in the group

CTRL+HOME

Display (without selecting) the last item on the timeline (if items are not grouped) or the last item in the group

CTRL+END


When a group is selected

To do this

Press

Expand the group

ENTER or RIGHT ARROW

Collapse the group

ENTER or LEFT ARROW

Select the previous group

UP ARROW

Select the next group

DOWN ARROW

Select the first group on the timeline

HOME

Select the last group on the timeline

END

Select the first item on screen in an expanded group or the first item off screen to the right

RIGHT ARROW


When a unit of time on the time scale for days is selected

To do this

Press

Move back in increments of time that are the same as those shown on the time scale

LEFT ARROW

Move forward in increments of time that are the same as those shown on the time scale

RIGHT ARROW

When the lower time scale is selected, select the upper time scale

SHIFT+TAB

When the upper time scale is selected, select the lower time scale

TAB

When the lower time scale is selected, select the first item on screen or the first group on screen if items are grouped

TAB


	See Also
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Lesson: About keyboard shortcuts
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Lesson: Keyboard Shortcuts for Outlook Calendar
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Lesson: Keyboard Shortcuts for Outlook Contacts
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Lesson: Keyboard Shortcuts for Outlook Mail
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Lesson: Specific keyboard shortcuts
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Lesson: Using the keyboard to work with menus
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Lesson: Using the keyboard to work with toolbars
[image: image58.png]



Use the keyboard to work in Outlook
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Work with the keyboard in Office


	
	


